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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “ XXXXX" is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP1603 Tiny Reference Design. Items discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

e The Microchip Web Site

e Customer Support

« Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP1603 Tiny Reference Design as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

e Chapter 1. “Product Overview” — Important information about the MCP1603
Tiny Reference Design

» Chapter 2. “Installation and Operation” — Includes instructions on how to get
started with this reference design board and a description of the reference design
board operation.

* Appendix A. “Schematics and Layouts” — Shows the schematic and layout
diagrams for the MCP1603 Tiny Reference Design.

* Appendix B. “Bill of Materials (BOM)” - Lists the parts used to build the
MCP1603 Tiny Reference Design.

© 2008 Microchip Technology Inc. DS51750A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl1l8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OXFF, “A”

Italic Courier New

A variable argument

file.o, where File can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS51750A-page 2
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Preface

RECOMMENDED READING

This user's guide describes how to use MCP1603 Tiny Reference Design. Other useful
documents are listed below. The following Microchip document is available and
recommended as supplemental reference resources:

« MCP1603 Data Sheet, “2.0 MHz, 500 mA Synchronous Buck Regulator”,
DS22042

« AN793 - “Power Management in Portable Applications: Understanding the
Buck Switchmode Power Converter”, DS00793

* MCP1603 Buck Converter Evaluation Board User's Guide, DS51652

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

« Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

e General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

 Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY
Revision A (October 2008)

« |nitial Release of this Document.

© 2008 Microchip Technology Inc. DS51750A-page 3
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Chapter 1. Product Overview

1.1 INTRODUCTION

Step-down converter choices include a variety of linear and switching regulators.

The MCP1603 500 mA synchronous buck regulator provides a low profile, cost
effective, and efficient solution for devices like cellular telephones, USB-powered
devices and hand held instruments. The device provides a solution with minimal board
space because of the high-frequency operation, which reduces the size requirements
of the external inductor and capacitor and the 1 mm maximum height TSOT package.
The MCP1603 switches at a fixed frequency of 2.0 MHz when operating at a heavy
load. This provides a low-noise, small size solution. When operating at light loads,
the MCP1603 automatically changes operation to a pulse frequency modulation (PFM)
mode to minimize quiescent current drawn from the input source. No intervention is
necessary for smooth transition from one mode to another.

This chapter covers the following topics:

« What is the MCP1603 Tiny Reference Design?
* What the MCP1603 Tiny Reference Design Kit includes?

© 2008 Microchip Technology Inc.

Input MCP1603 Vour
Voltage Buck 500 mA
2.7V - 5.5V Regulator E (maximum)
FIGURE 1-1: MCP1603 Tiny Reference Design Block Diagram.
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1.2 WHAT IS THE MCP1603 TINY REFERENCE DESIGN BOARD?

The MCP1603 Tiny Reference Design demonstrates the use of Microchip's MCP1603
device in a step-down application. The evaluation board is a fully functional platform to
evaluate the MCP1603 buck regulator over the input voltage, output voltage and
current range of the device. The evaluation board is designed to show off one of the
main advantages of MCP1603 - its small size.

Test points are provided to allow easy connection of the input voltage source and the
output load.

FIGURE 1-2: MCP1603 Tiny Reference Design Board Size.

1.3 WHAT THE MCP1603 TINY REFERENCE DESIGN BOARD KIT INCLUDES?

This MCP1603 Tiny Reference Design kit includes:
Three separate MCP1603 Tiny Reference Design boards with the following output
voltage options:
- Fixed 3.3V using the MCP1603T-3301/0S
- Fixed 1.8V using the MCP1603T-1801/0S
- Fixed 1.2V using the MCP1603T-1201/0S
* Analog and Interface Products Demonstration Boards CD-ROM
- MCP1603 Tiny Reference Design (DS51750)

DS51750A-page 6 © 2008 Microchip Technology Inc.
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Chapter 2. Installation and Operation

2.1 INTRODUCTION

The MCP1603 Tiny Reference Design is designed to demonstrate Microchip's
MCP1603 in a fixed output voltage configuration. The board is designed to
demonstrate how to generate both positive and negative rails using the MCP1603. The
MCP1603 is a 500 mA synchronous buck regulator that features both Pulse Frequency
Modulation (PFM) and Pulse Width Modulation (PWM). The PFM mode is used at light
loads to improve system efficiency while the 2.0 MHz PWM mode is entered at heavy
loads. The transition between PFM and PWM modes automatically occurs without any
external intervention. The MCP1603 is available in both adjustable parts that require
an external divider to set the output voltage and fixed output voltage parts. The high
switching speed and TSOT package (1 mm maximum height) make the MCP1603 ideal
for space constrained applications that require an efficient stepped down voltage.

2.2 FEATURES

The MCP1603 Tiny Reference Design has the following features:

« Ultra compact size and low profile 500 mA converter design
« Wide Input voltage range from 2.7V to 5.5V
» Fixed output voltages: 3.3V, 1.2V, 1.8V as well as -1.2V and -1.8V (from 3.3V

supply)
« Test points for connecting input voltage source and external load

2.3 GETTING STARTED

The MCP1603 Tiny Reference Design is fully assembled and tested for evaluating the
MCP1603 device. The board requires the use of an external input voltage source of
2.7V to 5.5V and an external load capable of 500 mA.

2.3.1 Power Input and Output Connection

Powering the MCP1603 Tiny Reference Design (Positive Output Voltage
Configuration)

1. Connect the positive side of the input source (+) to V.

2. Connect the negative or return side (-) of input source to GND. Refer to
Figure 2-1. The input voltage must be within the range of 2.7V to 5.5V.

© 2008 Microchip Technology Inc. DS51750A-page 7
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Vin Uout
2.7V - 5.5V
+
cCie —— | )
H = Vour
Gnd = s — -
N N3
FIGURE 2-1: Positive Output Voltage Setup Configuration Diagram.

Powering the MCP1603 Tiny Reference Design (Negative Output
Configuration

1. Connect the positive side of the input source (+) to V.

2. Connect the negative or return side (-) of input source to Voyt. Refer to
Figure 2-2. In this configuration the output voltage will appear between the Vg1
terminal and GND terminal of the board.

Note: For negative voltage generation the following condition must be met:
Vin-VouT < 5.5V. For example, if generating -1.2V output,
V|n-(-1.2V) < 5.5V, therefore, V| < 4.3V.

The MCP1603 device will be able to provide full load current in this configuration.

Vin Uout
Vin i | _
¢ ‘am — v
ouT
Gnd U1 — Gnd (Negative)
|
"D +
FIGURE 2-2: Negative Output Voltage Setup Configuration Diagram.

Applying Load to MCP1603 Tiny Reference Design Board (Positive
Output Configuration)

1. Connect the positive side of the load (+) to Vour

2. Connect the negative side of the load (-) to GND. Refer to Figure 2-1 and
Figure 2-2. The maximum load current should not exceed 500 mA.

As an alternative, a resistor can be connected between GND and Vgyt. The value of
this resistor must be sized such that the maximum load current does not exceed
500 mA for the selected output voltage.

DS51750A-page 8 © 2008 Microchip Technology Inc.
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Appendix A. Schematics and Layouts

A.1 INTRODUCTION AND HIGHLIGHTS
This appendix contains the following schematics and layouts for the MCP1603 Tiny
Reference Design:
* Board - Schematic
» Board - Top Silk Layer
» Board - Top Metal Layer
« Board - Bottom Metal Layer

© 2008 Microchip Technology Inc. DS51750A-page 9
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BOARD - SCHEMATIC
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Schematics and Layouts

A.3 BOARD - TOP PADS AND SILK-SCREEN

A.4 BOARD - TOP PADS AND TRACE

A.5 BOARD-BOTTOM TRACE

00330—K/
MICROCHIP
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NOTES:
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Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)
Qty | Designator Description Manufacturer Part Number
C1,C2 10uF, 6.3V, 0603 Ceramic Capacitor Panasonic® - ECG ECJ-1VB0J106M
L1 4.7uH, 740mA Inductor TDK Corporation VLF3012AT-4R7TMR74
PCB RoHS Compliant Bare PCB, MCP1603 | Microchip Technology Inc. |104-00220
Tiny Reference Design Board
4 TP1, TP2, PC Test Point Compact SMT Keystone Electronics® 5016
TP3, TP4
1 Ul 500 mA Synchronous Buck Regulator | Microchip Technology Inc. | MCP1603T-1201/0S
in SOT23-5 Package
1 Ul 500 mA Synchronous Buck Regulator | Microchip Technology Inc. | MCP1603T-1801/0S
in SOT23-5 Package
1 Ul 500 mA Synchronous Buck Regulator | Microchip Technology Inc. | MCP1603T-3301/0S
in SOT23-5 Package
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM

used in manufacturing uses all RoHS-compliant components.

© 2008 Microchip Technology Inc.
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